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El Model 12 tiene funciones de control DAW. Al ajustarlo al
modo de control DAW, podra usar sus controles para la gestion
basica de su aplicacién DAW. Esto incluye el control de fader,
anulacién o muting, panorama, funcion solo, reproduccion,
parada y otras funciones de transporte.

Esta unidad admite la emulacion de protocolos Mackie Control
(MCU) y HUI, por lo que podra controlar Cubase, Digital
Performer, Logic, Live, Pro Tools, Cakewalk y la mayoria de las
otras aplicaciones DAW principales.

Derechos de propiedad intelectual

® TASCAM is a registered trademark of TEAC Corporation.

® Microsoft and Windows are either registered trademarks or
trademarks of Microsoft Corporation in the United States
and/or other countries.

® Apple and Mac are trademarks of Apple Inc. in the United
States and other countries.

® Avid and Pro Tools are either registered trademarks or
trademarks of Avid Technology, Inc. or its subsidiaries in the
United States and/or other countries.

® Cubase are registered trademarks of Steinberg Media
Technologies GmbH.

® Cakewalk is a registered trademark are trademarks of
BandLab Technologies Inc.

® Other company names, product names and logos in this
document are the trademarks or registered trademarks of
their respective owners.



Operaciones del Model 12

Preparativos en la unidad

Audio en el modo de control DAW

En el modo de control DAW sélo podra escuchar el audio
recibido a través de los canales 1-2 del Model 12.

Realice los ajustes siguientes seguin sea necesario.

® Para controlar el DAW mientras escucha el audio master del
DAW a través de esta unidad, ajuste el interruptor MODE de
los canales 1-2 del Model 12 a“PC"y ajuste la salida audio
master del DAW a esos canales.

® En la pantalla MTR/USB SEND POINT, elija cualquier ajuste
distinto a“PRE COMP” (valor por defecto). Para enviar la
entrada LIVE o directa del canal 1-2 desde esta unidad al

ordenador, ajuste el interruptor MODE a “LIVE” (esto desactiva

la monitorizacién del sonido del DAW).

El estado de la sefal audio enviada al ordenador varia de
acuerdo al ajuste de la pantalla MTR/USB SEND POINT. Para
mas detalles, vea “Ajustes de la pantalla MTR/USB SEND
POINT” en pag. 4.

Conexion con un ordenador

Consulte la seccion “Conexidn de un ordenador”de “3 -
Preparativos” del manual de instrucciones del Model 12y
conéctelo a un ordenador.

Consulte también“12 - Funciones de interface audio USB"y
realice los ajustes.

Puesta en marcha del modo de control DAW

1. Ajuste el interruptor MODE del canal 1-2 del Model 12 de
acuerdo al uso que vaya a dar.

2. Con lagrabadora del Model 12 parada, elija DAW
CONTROLLER en la pantalla MENU y acceda a la pantalla
MODE.

Para saber como usar las pantallas, vea “Operaciones de
menu”en “2 — Nombres y funciones de las partes” del
manual de instrucciones.

HLU - Liw

HUI - Prn TDDlS

MCU - Cubasze
=5l I I

3. Elija el modo de control para el DAW que esté usando.
Para ver mas detalles acerca del ajuste, consulte el manual
de la aplicacion DAW que esté usando.

Opciones: MCU - Live, HUI - Pro Tools, MCU - Cubase,
MCU - Cakewalk, MCU - Logic, MCU - DP,

MCU - Cubasis, MCU - Studio One, MCU - Reaper

4, Pulse el dial MULTI JOG.
Aparecerd un mensaje de confirmacion.

DAL COHTREOLLEFR
Start the DAL

control ler mode.
Are wou sure 7

Pulse el boton F1 IIEEM para volver a la pantalla MODE.

5. Pulse el botén F4 IE=A.

Esto hard que aparezca la pantalla DAW CONTROLLER y
permitira el control del DAW.

AN COMTEOLLER

12245678
SOLD Qo0 Qo Q00

MARKER ——
S EE

¢ Inmediatamente después de la conexion con el DAW, asi
como después de que haya hecho ajustes en el DAW, los
ajustes de dicho DAW y el estado y las posiciones de los
botones, mandos y faders del Model 12 no coincidiran. En ese
caso, modifique los ajustes del DAW para hacerlos coincidir
con los del Model 12 o use los botones, mandos y faders del
Model 12 para ajustarlos a los valores del DAW.

e Siapaga la unidad mientras estd activo el modo de control
DAW, seguira en dicho modo cuando vuelva a encenderla.
Para usarla en el modo habitual, salga del modo de control
DAW usando el boton F1 IEEd.

Salida del modo de control DAW

1. Pulse el botén F1 para hacer que aparezca el
mensaje siguiente.

I LA COMTROLLER I

Are gou sure

to exit?y

2. Pulse el boton F4 BT para salir del modo de control
DAW.

TASCAM Model 12 Manual de modo de control DAW 3



Operaciones del Model 12

Ajustes de la pantalla MTR/USB SEND POINT

La sefal audio enviada al ordenador depende de los ajustes del interruptor MODE del Model 12y del ajuste de la pantalla MTR/USB

SEND POINT.

Para ver mas detalles acerca de los ajustes de la pantalla MTR/USB SEND POINT, vea “Seleccién de la posicién desde la que son enviadas
las sefiales de grabacion para cada canal” dentro de “Funciones de mezclador” en el capitulo “9 — Otras funciones” del manual de

instrucciones.

MTR/USB SEND POINT |COMP EQ Interruptor MODE | Audio enviado al ordenador

LIVE Es enviado el sonido de las tomas de entrada.
PRE COMP Desactivado Desactivado PC Es enviado el sonido de las tomas de entrada.

MTR Es enviado el sonido de las tomas de entrada.

LIVE Es enviado el sonido de las tomas de entrada.
POST COMP Activado Desactivado PC Es enviado el sonido del ordenador.

MTR No es enviado ninguin sonido.

LIVE Es enviado el sonido de las tomas de entrada.
POSTEQ Activado Activado PC Es enviado el sonido del ordenador.

MTR No es enviado ningtin sonido.

Independientemente de los ajustes anteriores, COMP/EQ queda activado para el sonido desde el ordenador.
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Operaciones del Model 12

Controles de mezclador que puede usar con el modo de control DAW

Puede usar los controles siguientes del Model 12 en el modo de control DAW.

® Estan activos y disponibles los mandos, interruptores y faders que aparecen en azul en la ilustracion siguiente.

Fader FX

Esto controla el fader master del DAW.

Dial MULTI JOG

Puede usarlo para funciones de localizacion.

Botones de funcién

Sus funciones dependen de lo que aparezca en la pantalla DAW CONTROLLER.
Pulse el boton MENU para cambiar la operatividad de los botones de funcién.

e B 2 W e

£/

TASCAM

H

1655/0050

silo

Pantalla DAW CONTROLLER MARKER

LW CONTROLLER

123453678
SO0 2D D QD DD D

MARKER ——
= EER

® Use el boton F2 para establecer marcadores.

® Use los botones F3 IEE=3M y F4 BMEEE para desplazarse entre
los marcadores.

El estado del interruptor SOLO de la aplicacién DAW
es indicado por el elemento SOLO de la pantalla DAW
CONTROLLER.

O : Interruptor SOLO desactivado (off)
@ : Interruptor SOLO activado (on)

Pantalla DAW CONTROLLER TRACK

LW CONTROLLER

123453678
SO0 O QD QD DD

— TRACK —
oLl = B = |

® Pulse el boton F2 IEXEM para cambiar la funcion de
repeticién del DAW.

® Use los botones F3 IEE y F4 BEEEM para desplazarse entre
las pistas que pueden ser controladas.

Una vez que haya modificado las pistas que pueden ser
controladas, los ajustes del DAW y el estado y las posiciones
de los botones, mandos y faders del Model 12 no coincidiran.
En ese caso, modifique los ajustes del DAW para hacerlos
coincidir con los del Model 12 o use los botones, mandos y
faders del Model 12 para ajustarlos a los valores del DAW.
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Operaciones del Model 12

Entrada y salida de audio USB en el modo de control DAW

Cuando esté activo el modo de control DAW, solo podra escuchar la entrada audio recibida a través de los canales 1-2 del Model 12.

Al ajustar los canales 1-2 del Model 12 para que sean las salidas audio master del DAW, podra monitorizar el sonido con el Model 12
mientras utiliza el DAW.

Podra usar los siguientes controles del Model 12 mientras esté en el modo de control DAW.

® Los mandos, interruptores y botones que estan dentro del recuadro verde en la ilustracion siguiente estan disponibles para controlar
el sonido enviado al ordenador.

® Los mandos, interruptores y faders que aparecen en azul en esa ilustracion estan disponibles para controlar el sonido procedente del
ordenador.

® Independientemente de la operacién, los interruptores rojos de la ilustracién de abajo siempre estan activados.

® Independientemente de la operacion, los mandos, interruptores y faders que aparecen en amarillo en la ilustraciéon de abajo quedan
fijos en los ajustes siguientes para el sonido procedente del ordenador.

Mando PAN (1-2) Independientemente del uso del mando, los canales 1y 2 son siempre Ly R, respectivamente.
Faders de canal (1-2) Independientemente del uso del fader, siempre estan en 0 dB.
Interruptores AUX 1/2/MAIN Independientemente del uso del interruptor, siempre estan en MAIN.

e ST S e e e e e L A

oo ML T 0 T (0 MG O [0

(Soorgausun]
I

ssssssssss

e Siapaga la unidad mientras estd activa en el modo de control DAW, seguira en ese mismo modo cuando la vuelva a encender.
e Para usar el modo normal, salga del modo de control DAW con el boton F1 IESEAL.
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Realizacion de ajustes en distintos DAW

Para activar la recepcién de mensajes desde la aplicacion 3. Ajuste la entrada (Input) a “Model 12 MIDI (Port 2)".

DAW, active primero el Model 12 en el modo de control DAW y

configure después la aplicacion DAW. oreforemees o
Live

Windows

Las pantallas siguientes son del Live versién 10.1.6.

1. Haga clic en“Options” > “Preferences..."”

L Model-12 DAW CON
File Edit Create Vie

G [Meodel-12 DAW COMNTROLLER SETTING] - Ableto:

DI Map Ctrl+M
Edit Key Map Cirl+K

~  Computer MID| Keyboard M

External Sync
~ Delay Compensation
4.

Ajuste la salida (Output) a “Model 12 MIDI (Port 2)"

Reduced Latency When Monitoring

Time Ruler Format >
Preferences u

Smaller Launch Quantization Ctrl+1

Larger Launch Quantization Ctrl+2

Triplet Launch Quantization Ctrl+3 [ Show |
~  Launch Quantization Enabled Ctrl+4 [ on |

Snap Automation to Grid

Fixed Grid Ctrl+5

Draw Mode B | [None

Bl Ctrl+Shift+F e || Microsoft GS Wavetable Synth
+  Chase MIDI Notes | Model 12 MIDI (Part 2)

e ————

~  Solo Switches

|

Cue Switches

~  Soloin Place

Lock Envelopes

MIDI Arrangement Overdub

2. Elija la pestafa“Link MIDI"y ajuste la superficie de control El boton M del Model 12 se iluminara para indicarle que el
(Control Surface) a“MackieControl”. control remoto esta activado.
Preferences n

[Model 12 MIDI (Pc]|
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Realizacion de ajustes en distintos DAW

Mac
Las pantallas siguientes son del Live versién 10.1.7.
1. Hagaclicen”Live”>“Preferences...”

g liile Edit Create View Options Help

Ut Live

Preferences...

Services >

Hide Live #8H
Hide Others "\_&H
Show All

Quit Live #Q

2. Elijala pestana“Link MIDI"y ajuste la superficie de control
(Control Surface) a“MackieControl”.

Preferences

MackieControl _¥||Model 12 (DAW C(v| |Model 12 (DAW C(v|
v,

Launchkey Mini MK3
Launchkey MK2
Launchpad
Launchpad Mini MK3

MackieControl

3. Ajuste la entrada (Input) a“Model 12 MIDI (DAW Control
IN)"

Preferences
| Show |
| on_ |

MackieControl _v||Model 12 (DAW C(v| |Model 12 (DAW C(v|
o —

aane ~—

il|Model 12 (DAW Control IN) | v

4, Ajuste lasalida (Output) a“Model 12 (DAW Control OUT)".

Preferences

MackieControl _¥||Model 12 (DAW C(v||Model 12 (DAW C(v|

Model 12 (DAW Control OUT)

El boton M del Model 12 se iluminard para indicarle que el
control remoto esta activado.
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Controles que puede usar con el DAW

Los controles siguientes del Model 12 pueden ser usados para
controlar la aplicacion DAW.

® Botén F2 (Pantalla DAW CONTROLLER MARKER)
e Boton F3 HEZAM (Pantalla DAW CONTROLLER MARKER)
e Boton F4 BEEM (Pantalla DAW CONTROLLER MARKER)
@ Boton F2 IEE=M (Pantalla DAW CONTROLLER TRACK)
e Boton F3 BESM (Pantalla DAW CONTROLLER TRACK)
e Boton F4 BEEM (Pantalla DAW CONTROLLER TRACK)
@ Dial MULTI JOG (funcion de localizacion)

® Botones <« /»>>

® Boton M

® Boton »- /11

® Botén @

® Mandos PAN (1-6, 7/8-9/10)

® Botones REC (1-6, 7/8-9/10)

® Interruptores MUTE (1-6, 7/8-9/10)

® Interruptores SOLO (1-6, 7/8-9/10)

® Faders de canal (1-6, 7/8-9/10)

® Fader FX (control de fader master)

Inmediatamente después de la conexion con el DAW, asi
como después de que haya hecho ajustes en el DAW, los
ajustes de dicho DAW y el estado y las posiciones de los
botones, mandos y faders del Model 12 no coincidiran. En ese
caso, modifique los ajustes del DAW para hacerlos coincidir
con los del Model 12 o use los botones, mandos y faders del
Model 12 para ajustarlos a los valores del DAW.



Realizacion de ajustes en distintos DAW

Pro Tools

Las pantallas siguientes son del Pro Tools12 Ultimate version
2019.12.

1. Haga clic en“Setup” > “Peripherals...”

[@ o Tools
File Edit View Track Clip Event AudioSuite Optmrl Setup 'mdnw Avid Link  Help

B Edit: TASCAM Model-12 DAW CONTROLLER SETTING Sl
Playback Engine...
Qi pllocaion

Video Sync Offset...

Session Ctrl+@
Current Feet+Frames Position...
Current Timecode Position...
External Timecode Offset...

MIDI

Click/Countoff...

Preferences...

2. Elijala pestaia “MIDI Controllers”y ajuste el tipo (Type) a
“HUI"

MIDI Controllers

3. Ajuste Receive From a“Model 12, DAW Control IN".
En un Magc, ajustelo a “Model 12 MIDI DAW Control IN”.

Peripherals

MIDI Controllers.

4, Ajuste Send To a“Model 12, DAW Control OUT".
En un Mag, ajustelo a“Model 12 DAW Control OUT".

Peripherals

MIDI Controllers.

5. Hagaclicen“OK"

Peripherals X

MIDI Controllers

El boton M del Model 12 se iluminard para indicarle que el
control remoto esta activado.

Controles que puede usar con el DAW

Los controles siguientes del Model 12 pueden ser usados para
controlar la aplicacién DAW.

® Boton F2 (Pantalla DAW CONTROLLER MARKER)
@ Botén F2 IETEM (Pantalla DAW CONTROLLER TRACK)
e Botén F3 HE=M (Pantalla DAW CONTROLLER TRACK)
e Boton F4 I (Pantalla DAW CONTROLLER TRACK)
® Dial MULTI JOG (funcién de localizacion)

® Botones «<«/»p>

® Boton W

® Boton » /11

® Botén @

® Mandos PAN (1-6, 7/8-9/10)

® Botones REC (1-6, 7/8-9/10)

® Interruptores MUTE (1-6, 7/8-9/10)

® Interruptores SOLO (1-6, 7/8-9/10)

® Faders de canal (1-6, 7/8-9/10)

Inmediatamente después de la conexion con el DAW, asi
como después de que haya hecho ajustes en el DAW, los
ajustes de dicho DAW y el estado y las posiciones de los

botones, mandos y faders del Model 12 no coincidiran. En ese
caso, modifique los ajustes del DAW para hacerlos coincidir

con los del Model 12 o use los botones, mandos y faders del
Model 12 para ajustarlos a los valores del DAW.
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Realizacion de ajustes en distintos DAW

6. Haga clicen”OK"

€ Studio Setup x
Las pantallas siguientes son del Cubase 10.5. —
Devices MIDIIN2 (Model 12 MIDI) v
. u NN . ”
1. Haga clic en“Studio” > “Studio Setup... Chord ods S
Chord Pads
pig User Commands
@ MIDI Port Setup |
[} Remote D Button Category Command
& Fle Edit Project Audic MIDI Media Transpd ndow Hub Help PR Usera
T T T Track Quick Controls User B
Tremmeet F1
MixConsole Record Time Max Shift+F1
Video F2
MixConsole in Project Window - Video Player Shift+F2
b VST Audio System B
VST Plug-in Manager Model Mixer ASIO S
Audio Performance... ST System Link 7]
et
Video Player :;'&
+ & On-Screen Keyboard...
] ABAFrIRI More Options o e
| s Suicch Dy
Studio Setup Enable Auto Select
W Relay Click
Reset Apply

l oK l Cancel

2. Elija“Remote Devices”y haga clic en el simbolo + de la

esquina superior izquierda de la ventana. El botén M del Model 12 se iluminara para indicarle que el

control remoto esta activado.

[ e Controles que puede usar con el DAW
- Los controles siguientes del Model 12 pueden ser usados para
controlar la aplicacién DAW.
e Botén F2 (Pantalla DAW CONTROLLER MARKER)
v e Boton F3 IEZM (Pantalla DAW CONTROLLER MARKER)
e Botén F4 MEEM (Pantalla DAW CONTROLLER MARKER)
3. Elija“Mackie Control". ® Boton F2 EEM (Pantalla DAW CONTROLLER TRACK)
— _ e Boton F3 HESMM (Pantalla DAW CONTROLLER TRACK)
e Boton F4 HESH (Pantalla DAW CONTROLLER TRACK)
S I e Dial MULTI JOG (funcién de localizacién)
itii.’iiiif;lim ® Botones <« /»>
O  Boton m
Rl S22 ® Botén /11
e ® Boton @

. ® Mandos PAN (1-6, 7/8-9/10)
4. Ajuste“MIDI Input”a“MIDIIN2 (Model 12 MIDI)".

En un Mac, ajustelo a“Model 12 MIDI DAW Control IN” ® Botones REC (1-6,7/8-9/10)
® [nterruptores MUTE (1-6, 7/8-9/10)
€ Studio Setup X
= S ® Interruptores SOLO (1-6, 7/8-9/10)
T a e ® Faders de canal (1-6, 7/8-9/10)
o o a0 e ® Fader FX (control de fader master)
e E;J:o: — r. ~  MIDIIN2 (Model 12 MIDI ~
e = e ATENCION
v Inmediatamente después de la conexién con el DAW, asi
| s st como después de que haya hecho ajustes en el DAW, los

ajustes de dicho DAW y el estado y las posiciones de los
5. Ajuste“MIDI Output”a“MIDIOUT2 (Model 12 MIDI)" botones, mandos y fa.ders del Model 12 no comadwap. En.ese
. " " caso, modifique los ajustes del DAW para hacerlos coincidir
En un Mag, ajustelo a“Model 12 DAW Control OUT".
con los del Model 12 o use los botones, mandos y faders del
Model 12 para ajustarlos a los valores del DAW.

€ Studio Setup X

Mackie Control

Devices MIDIIN2 (Model 12 MIDI) v

Chord Pads MIDIOUT2 (Modei 12 MIDI) v

Crord Pads

WD) veerCommangs | MotComnected
ser Commands

@ MIDI Port Setup

Button Category @ Microsoft GS Wavetable Synth

Remote Devices

Usera
UCEHET ESErely L ~ MIDIOUT2 (Model 12 MIDI)
ransport F
Record Time Max Shift+F1
Video r2
i Video Player ShiftrF2
ST Audio System )
Moge! Mixer ASIO T
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Realizacion de ajustes en distintos DAW

4, Ajuste“Controller/Surface”a“Mackie Control”.
Cakewalk )

reference %
Las pantallas siguientes son del Cakewalk versién 2020.01. Ao | Setectanycomtot sracee) you want o v n Cakewat
. . Devices import AGT Data |
1. Haga clicen“Edit” > “Preferences...” e Setings - 0
Playback and Recording Controller/Surface In Part OutPort AW WA calor
Configuration File
Alodel-12 DAW CONTROLLER SETTING - Track] Sync and Caching
iews Inset Process Project Utilities Window et -
Devices Controller/Surface Settings %
&= Sl Import Playback and Recording R¢ Controller/Surface.

Redo Ctrl+Y, Ctrl+Shift+Z Instruments

o Tracks k [ rrm— [ACT WIDI Cortioler Cancel

History... kel G Sutace — (O Bonsole View (@) Al Strips

; e Drum Map Manager

Select File
Folder Locations MIDI Devices...

Aim Assist Audio Data

Cut Ctrl+X . " Yo ”

. e 5. Ajuste“Input Port”a“MIDIIN2 (Model 12 MIDI)".

Cut Special... Ctrl+ Alt+X

Copy Ctrl+Insert, Ctrl+C

LCopy Special... Ctrl+Alt+C Preference ®

Ea:t& Ctrl + I\". i Audio || Select any control surface(s) you want to use in Cakewalk.

Paste Special... Ctrl+Alt+V ot LioRroess X 4

Driver Settings

Delete Playback and Recording Contraler/Surfics In Part Out Part Al W WAlookor

Delete Special... Configuration File
Syne and Caching

Preferences... miDI

i Controller/Surface Settings X

Devices g

'y [ 1Modeli2

N odel
Playback and Recording Cortrollr/S utace
Instruments Mackie Control v

Cancel

[Frer—

Drum Map Manager

Input Port

(O Cansale View @)A1 Strips

Help

File

2. Elija“Control Surfaces”.

Audio Data

MIDI Devices.

Preferences x

~] [ seectany contot sufaces you want to use n abewal 6. Ajuste“Output Port”a“MIDIOUT2 (Model 12 MIDI)".

perces X
Driver Settings Connected Controllers/S urfaces P -

Playback and Recording Contraller/Surface In Port Out Fort A W Wl colar

Configuration ile Audio A || Select any control surface(s) you want to use in Cakewalk.

Syn and Coching Deces mport AT Dt X 4
o Driver Settings

Devices. Playback and Recording Gontroller/Surface In Port Out Port A W, WAl color

Playback and Recording R resh Frequency fmiliseconds) Configuration File

Sync and Caching

WAl D
antra Track View /| Bonsols View Ofrsckvien (O Banscls View (@4l trips MiDt
Devices

Controller/Surface Settings x
File Playback and Recording Controller/S utace [ o ]
Folder Locations Instruments Mackie Control v
Cancel o
Audia Data [ controlSurfaces | Input Port (O Canzste View @) 41 Strips

Hel
VST Settings Drum Map Manager HIDINZ (Model 12MIDI) Ela

Initialization File File Dutput Port
Advanced Folder Locations MID! Devices.
Project Audio Data
Record VST Settings
MiDI . Initinlizatin, Fils
O Basic @ Advanced 0K Gancel Apply Help

7. Hagaclicen"OK"

3. Hagaclic en el simbolo de estrella que aparece en la

esquina superior derecha de la ventana -
q p : | e
Devices import AGT bta x
Preferences. Driver Settings
Audio a you Playback and Recording Controller/Surface In Port Out Port Ao W WA color
Devices Configuration File Mackie Dontrol - 1 MIDINZ (hodel 12 M v MIDIOUT2 (Model 12 v 4 [} -
Driver Settings Sync and Caching
Playback and Recording Gantraler.Surface In Fort outPort Al W W oolor MiDI
Configuration File Devices Controller/Surface Settings X
DI Playback and Recording R Controller/S urface
Devices Instruments ! Mackie Control ~ g ;
Playback and Recording rrem Freasenoy tzenonis [SCantrol Surfaces ] Input Port : () Gonsole View (8) 41 Strips
Instruments Drum Map Manager MIDIINZ (Model 12MIDI)  ~ 2
[FrmerE——] Tracken (7] Gonsoe View Orasovin O ansole view @ IStigs File Output Port
Drum Map Manager Folder Locations MIDIOUT2 (Model 12MIDI ~ MIDI Devices.
e Audio Data
VST Settings
Advanced
pogect
MIDI v
O Basic @ Advanced [=[3 Caneel ngply Help.

El boton M del Model 12 se iluminard para indicarle que el
control remoto estd activado.
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Realizacion de ajustes en distintos DAW

Controles que puede usar con el DAW

Los controles siguientes del Model 12 pueden ser usados para

controlar la aplicacién DAW.

o Boton F3 IEZEM (Pantalla DAW CONTROLLER MARKER)
e Botén F4 HEEM (Pantalla DAW CONTROLLER MARKER)
@ Botén F2 IETEM (Pantalla DAW CONTROLLER TRACK)
e Botén F3 HE=M (Pantalla DAW CONTROLLER TRACK)
e Boton F4 MM (Pantalla DAW CONTROLLER TRACK)
® Dial MULTI JOG (funcién de localizacion)

® Botones <«/p>

® Boton H

® Boton /11

® Botén @

® Mandos PAN (1-6, 7/8-9/10)

® Botones REC (1-6, 7/8-9/10)

® Interruptores MUTE (1-6, 7/8-9/10)

® nterruptores SOLO (1-6, 7/8-9/10)

® Faders de canal (1-6, 7/8-9/10)

Inmediatamente después de la conexion con el DAW, asi
como después de que haya hecho ajustes en el DAW, los
ajustes de dicho DAW y el estado y las posiciones de los

botones, mandos y faders del Model 12 no coincidiran. En ese
caso, modifique los ajustes del DAW para hacerlos coincidir
con los del Model 12 o use los botones, mandos y faders del

Model 12 para ajustarlos a los valores del DAW.
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Logic Pro

Las pantallas siguientes son del Logic Pro X version 10.4.8.

1.

3.

Haga clic en “Logic Pro X" > “Preferences” > “Advanced
Tools...”

LogicProX ile Edit Track Navigate Record Mix View Window 1 Help

B Model-12C

General...
Audio...
Key Commands Recording...

. MIDL...
Sound Library > Display...
Provide Logic Pro Feedback Score...
Download Logic Remote...

Movie...

Learn About

Services

Hide Logic Pro X ®
Hide Others Reset All
Show All

Advanced Tools...

Except Key C

Plug-in Manager.

Quit Logic Pro X Chord Grid Libra

Ponga “ticks” en todos los recuadros.

Preferences

® B o).

v Show Advanced Tools
luding: project alternatives
additio more. Ad

Additional Options

v Audio
E o e igura udio editing experts.

v Surround
Enables all features for surr nd audio productions, and requires a surround speaker setup for monitoring.
real-time pr g of MIDI input and output streams in the Environment.
nev and edit any functional detail of e;
v Score

Enables the full feature set ¢ the Score window for notation experts.

editing fi_ctionality, including: beat mapping, al

Gene Help Tags | MIDI Controllei

Auto  Manufacturer Model Name

Controller Assignments... Setup...




Realizacion de ajustes en distintos DAW

4, Haga clicen“New”>"Install...”
g Controles que puede usar con el DAW

Los controles siguientes del Model 12 pueden ser usados para
controlar la aplicacién DAW.

Boton F2 (Pantalla DAW CONTROLLER TRACK)
Boton F3 ME=MM (Pantalla DAW CONTROLLER TRACK)
Boton F4 BEEEM (Pantalla DAW CONTROLLER TRACK)
Dial MULTI JOG (funcion de localizacion)
Botones <<«/pp
Boton W
Boton »/11
Botén @
Mandos PAN (1-6, 7/8-9/10)
Botones REC (1-6, 7/8-9/10)
Interruptores MUTE (1-6, 7/8-9/10)
Interruptores SOLO (1-6, 7/8-9/10)
Faders de canal (1-6, 7/8-9/10)
o e Fader FX (control de fader master)

M-Audio USB Trigger Finger A
M-Audio (Midiman) iControl iControl ATENCION

kil Inmediatamente después de la conexién con el DAW, asi

HUI

(XK Control Surface Setup

5. Elija“Manufacturer: Mackie Designs”y “Model: Mackie
Control”y haga clic en“Add".

HUIChanel Stips orly U como después de que haya hecho ajustes en el DAW, los
e par— ajustes de dicho DAW y el estado y las posiciones de los

Mackie Designs Mackie Control Logic Control

botones, mandos y faders del Model 12 no coincidiran. En ese
e e caso, modifique los ajustes del DAW para hacerlos coincidir
wonome Monome 64 ' con los del Model 12 o use los botones, mandos y faders del
Netlie instrarints HOMPLETE KONTROL 551 Model 12 para ajustarlos a los valores del DAW.

Nektar IMPACT LX49

Mackie Designs Mackie Control Extender

Nocturn Keyboard
Mkl

6. En“Device: Mackie Control” ajuste “Output Port”a“Model 12
DAW Control OUT".

[ ] @ Control Surface Setup
Edit v New -
¥ Device: Mackie Control

ule: Logic Control
: Mackie Control

@ Mackie Control

Serial No.

up: Control Surface Group 1

7. En“Device: Mackie Control” ajuste “Input Port” a “Model 12
DAW Control IN".

Edit v New v

Control Surface Setup

¥ Device: Mackie Control

Output Port: Model 12 DAW Control OUT
Input B v Any

Model 12 DAW Control IN

@ Mackie Control

‘W CS Group: Control Surface Group 1

El boton M del Model 12 se iluminara para indicarle que el
control remoto esta activado.
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Realizacion de ajustes en distintos DAW

. e 5. Ajuste“Output Port”a“Model 12 DAW Conrtol OUT".
DP (Dlgltal Performer) En un Magc, ajustelo a“Model 12 DAW Control OUT".

Las pantallas siguientes son del Digital Performer 10.1. @y

1. Hagaclicen “Setup”>“Control Surface Setup...”

0 Mode-12 DAW CONTROLLER SETTING

43
4
45

File Edit View Region Audic Project Studi Lt Window  Help

W Command... Shift+Space
Commands Shift-L

ol -1 Unconfigured Ports ¥ l m
«or» KEP I B Conra O
> |7 I A
S ol e bt WLt ® 3 =

Bilfs

¥ Model 12 DAW Control OUT

Input Filter... Cancel P =R
TASCAM iXR (Missing)
US-322 (Missing)
US-366 (Missing)
US-1800 (Missing)
US-122 MKII (Missing)
US-144 MKII (Missing)
US-16x08 (Missing)
US-20x20 (Missing)
1182727 FMiccine)

Event Chasing..

Automation Setup...

Legend...

Time Formats Ctrle Ale=T

Frame Rats
Receive Sync...

Transmit Sync...

6. Haga clicen”OK".

Control Surface Setup...

Audio System

Control Surface

Configure Audio System
Audio System Clock

2. Hagaclic en el simbolo + que esté en la esquina superior
derecha de la pantalla.

o add a driver o your configuration.

El boton M del Model 12 se iluminara para indicarle que el

Cancel control remoto esta activado.
3. Ajuste la unidad a“Mackie Control”. Controles que puede usar con el DAW
Los controles siguientes del Model 12 pueden ser usados para
Control Surface controlar la aplicacién DAW.

o Boton F3 EEZEM (Pantalla DAW CONTROLLER MARKER)
o Boton F4 BEEE (Pantalla DAW CONTROLLER MARKER)
@ Boton F2 IEHEM (Pantalla DAW CONTROLLER TRACK)
e Boton F3 HE=M (Pantalla DAW CONTROLLER TRACK)
e Boton F4 MM (Pantalla DAW CONTROLLER TRACK)
® Botones <</ p»p

® Boton W

® Boton » /11

4. Ajuste”Input Port”a“Model 12 DAW Control IN". ® Boton @

En un Magc, ajustelo a“Model 12 MIDI DAW Control IN”". e Botones REC (1-6, 7/8-9/10)

® Interruptores MUTE (1-6, 7/8-9/10)
® [nterruptores SOLO (1-6, 7/8-9/10)
@ Faders de canal (1-6, 7/8-9/10)

® Fader FX (control de fader master)

PR

TASCAM IXR (Missing)

] Inmediatamente después de la conexién con el DAW, asi
e " como después de que haya hecho ajustes en el DAW, los
ajustes de dicho DAW y el estado y las posiciones de los
botones, mandos y faders del Model 12 no coincidiran. En ese
caso, modifique los ajustes del DAW para hacerlos coincidir
con los del Model 12 o use los botones, mandos y faders del

Model 12 para ajustarlos a los valores del DAW.

Madel 12 DAW Control IN-16
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Realizacion de ajustes en distintos DAW

Cubasis

Las pantallas siguientes son para Cubasis 3.3.

Esta unidad admite Cubasis 3.3 y posteriores.

1. Hagaclicen“SETUP”>“MIDI".

aOKY 2

SETUP HELP

Project MIDI Input Only for Armed Track
General
Audio Note Coloring
MIDI
Keys/Pads MIDI over Bluetooth
R Metronome Host

Mixdown / Freeze

2. Haga clic en“Ports” dentro de “Mackie Control/HUI"en la
ventana.

MIDI Learn

Send MIDI Clock

3. Enlaventana Select Mackie/HUI Ports, haga clic en“Model
12 DAW Control IN"y “Model 12 DAW Control OUT"y ajuste

ambos a “Mackie”.

Select Mackie / HUI Ports

Mackie

4, Active elicono que aparece dentro del recuadro rojo.

Mackie Control / HUI

Port

El boton M del Model 12 se iluminard para indicarle que el
control remoto esta activado.

Controles que puede usar con el DAW

Los controles siguientes del Model 12 pueden ser usados para
controlar la aplicacién DAW.

@ Boton F2 IEHEM (Pantalla DAW CONTROLLER TRACK)
e Boton F3 BE=M (Pantalla DAW CONTROLLER TRACK)
o Boton F4 I (Pantalla DAW CONTROLLER TRACK)
@ Dial MULTI JOG (funcién de localizacion)

® Botones <« /»>>

® Boton M

® Boton » /11

® Boton @

® Mandos PAN (1-6, 7/8-9/10)

® Botones REC (1-6, 7/8-9/10)

® Interruptores MUTE (1-6, 7/8-9/10)

® Interruptores SOLO (1-6, 7/8-9/10)

® Faders de canal (1-6, 7/8-9/10)

® Fader FX (control de fader master)

Inmediatamente después de la conexion con el DAW, asi
como después de que haya hecho ajustes en el DAW, los
ajustes de dicho DAW y el estado y las posiciones de los

botones, mandos y faders del Model 12 no coincidiran. En ese
caso, modifique los ajustes del DAW para hacerlos coincidir

con los del Model 12 o use los botones, mandos y faders del
Model 12 para ajustarlos a los valores del DAW.
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Realizacion de ajustes en distintos DAW

. 4, Ajuste Receive From to “MIDIIN2 (Model 12 MIDI)".
Studio One )

Las pantallas siguientes son de Studio One 5.2.1. Receive From None

1. Haga clic en“Studio One” > “Options..."

v MNone

Send To
B Studio One - MIDIINZ (Model 12 MIDI)

File Edit Song Tack Event Audio Transport View | StudioOne Help

¥ Mic Mix Link Studio One Activation.

1- Ampire Studio One Installation..

= + 1 Studio One Extensions.
I

Backup and Restore...
Activate Purchased ftems..
Sign out (mikio.nakayama@teac.jp) NOTA
& SoundCloud Client En un Mac, ajustelo a“Model 12 MIDI DAW Control IN".
A Macro Organizer .
5. Ajuste Send To a “MIDIOUT” (Model 1.2 MIDI)".

Language

MIDIIR

2. Hagaclic en el icono “External Devices” en la parte superior

de la ventana y haga clic alli en “Options”. None

MIDIOUTZ (Model 12 MIDI)
12 MIDI

S N

General Locations Audio Setup | External Devices Advanced

s NOTA

En un Mac, ajustelo a “Model 12 DAW Control OUT".
6. Haga clicen”OK".

Bl Options X

e N0 @ %

General Locations Audio Setup | External Devices Advanced

Receive From CkTcin

MIDIINZ (Model .IDI)

Add Edit

¥ Notify me if d are unavailable when Stu

Options S

3.

Macki

Mackie

Control

El boton M del Model 12 se iluminard para indicarle que el
control remoto esta activado.
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Realizacion de ajustes en distintos DAW

Controles que puede usar con el DAW

Los controles siguientes del Model 12 pueden ser usados para
controlar la aplicacién DAW.

® Botén F2 (Pantalla DAW CONTROLLER MARKER)
e Boton F3 HEZAM (Pantalla DAW CONTROLLER MARKER)
® Boton F4 BEEM (Pantalla DAW CONTROLLER MARKER)
e Botén F2 IEXTEM (Pantalla DAW CONTROLLER TRACK)
e Boton F3 MESEM (Pantalla DAW CONTROLLER TRACK)
e Boton F4 HEEM (Pantalla DAW CONTROLLER TRACK)
® Dial MULTI JOG (funcién de localizacién)

® Botones <««/p>p>

® Boton M

® Boton /11

® Botén @

® Mandos PAN (1-6, 7/8-9/10)

® Botones REC (1-6, 7/8-9/10)

® nterruptores MUTE (1-6, 7/8-9/10)

® Interruptores SOLO (1-6, 7/8-9/10)

® Faders de canal (1-6, 7/8-9/10)

® Fader FX (control de fader master)

Inmediatamente después de la conexion con el DAW, asi
como después de que haya hecho ajustes en el DAW, los
ajustes de dicho DAW y el estado y las posiciones de los
botones, mandos y faders del Model 12 no coincidirén. En ese
caso, modifique los ajustes del DAW para hacerlos coincidir
con los del Model 12 o use los botones, mandos y faders del
Model 12 para ajustarlos a los valores del DAW.
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Realizacion de ajustes en distintos DAW

REAPER

Las pantallas siguientes son de REAPER V6.38.

1. Haga clic en“Options” > “Preferences..”

9 X8_MicEQ_Tracks - REAPER v6.38
File Edit View Insert ltem TrackA[tu)ns Help

~  Record mode: normal

Record mode: time selection auto punch
Record mode: auto-punch selected items

New recording that overlaps existing media items

Auto-crossfade media items when editing
Trim content behind media items when editing

Always trim content behind razor edits

Show all takes in lanes (when room) Cerl+L
Take lane behavior

Show overlapping media items in lanes (when room)

Ripple edit per-track
Ripple edit all tracks
ltem grouping enabled Alt+Shift+G
Loop points linked to time selection

Snap/grid

Locking

Envelope points

Automation items

Metronome enabled

Metronome/pre-roll settings..

Solo in front

Pre-fader track metering

Show FX inserts in TCP (when size permits)
Show sends in TCP (when size permits)

Peaks display mode

Automatically scroll view during playback

Centinuous scrolling

Smooth seeking (seeks at end of measure)

Chase MIDI note-ons in project playback

External Timecode Synchronization

Show REAPER resource path in explorer/finder...
‘Customize menus/toolbars..
Themes

Layouts

Preferences...

2. Hagaclic en“Add” dentro de la ventana “Control surfaces/
OSC/web control”.

) REAPER Preferences &

Rendering | Contral surfaces/0SC/web contral
Appe arance
Medis
Pe sk, Wave forms
Fades/Orossfdes
Track Gontral Panels
Editing Behavior
Envelope Display
Automation

Mouse
Mouse Modifiers
MIDI Editor

Medis
MIDI
Wide o /Import/Mise

Plug-inz
Compatibilit

WST Add Edit Fe mawie [changes wil be applied imme distely]
ReWire /DX
Contrel curface displey update fequency: He (deFault: 15

ResSeript

[Jarn when errors opening surface MIDI devices

[J0iose contral surfsce devices when stopped snd nat active applioation

[ |[Fna Cancel | | Al
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3. Para“Control surface mode’, elija“Mackie Control Universal”

y haga clicen“OK".

5) =z

Gontral surfucas/08 Béwsb cantral

Rendaring @
Aopearance

Meda

Peaks/Weforms

Faes/Dross ks

Track Gontrol Panels
Edting Behavior

Envelope Displsy @ Control Surface Settings X
Automation
wouze gontrel urfe made
Vouse Modiers e SEFTO05 s reset T
WD) Edor
Mede
e
Ly ——
Puc-ns
Compettity
e s et
Rewwe/ox
st Gontrolsurhos dplay e
Reatote [Jwrn uhen evrers apen
Sonea80/aet | | Coun corot s
[
Ganel
4, Ajuste“MIDI input”a“MIDIIN2 (Model 12 MIDI)".
) Control Surface Settings X
Control surface mode: | packie Control Universal ~
MID input: |MIDIIN'2 (hiode| 12 MIDI) V\
MIDI output,
Surface offset tracks ]|
Size twesk: [5 | (eave at $ unless you know whst you're doing)
[[J1enore fader moves when fader is not beine touched
[[]tsp F1-F2 to g0 to markers
[Jtenare slabal bank offse ts (always map ta tracks specified)
One
En un Mac, ajustelo a“Model 12 MIDI DAW Control IN".
5. Ajuste"MIDI output”a“MIDIOUT2"” (Model 12 MIDI)".
J Control Surface Settings x

Control surface mode: | packie Control Universal ~
MID! input: | MIDIN? odel 12 MIDI) ~
MIDI output: (MIDIOUT2 Gvodel 12 MIDI ~

Surface offset (racks) [Mone
Microsaft G5 Wave tsble Synth

Size twesl

[tenore fader mevesW o
[CIMsp F1 -F8 to o to markers
[[Jtencre elobal bank offse ts Galways map to tracks specified)

Cancel

En un Mac, ajustelo a“Model 12 DAW Control OUT".



Realizacion de ajustes en distintos DAW

6. Haga clicen”OK"

) REAPER Preferences I %
Frendering | Dontrol surfanes/DE0/web control
e ——
#ppearance Mackie Gontrol (dew 457
Media
P shs/Wave forms
Fadss/Crossfad
Track Gontral Fanel

Editing Behavior
Envelope Display
Automation
Mouse
Mouse Modifiers
MIDI Editor

Media
Mo
Wideo/Import/Misc

Plug-ins

wST Add Edit Remoue (changes will be applied imme diste |y}
Lva

ReWire/DX Cantrol surface displsy updste frequancy; H (e fault: 151

ResSoript [[]Warn when errors opening surface MID| devices

FresMot

[ Glose control surface devices when stopped and not sctive spplication

[ To] DGR

El boton M del Model 12 se iluminard para indicarle que el
control remoto esta activado.

Controles que puede usar con el DAW

Los controles siguientes del Model 12 pueden ser usados para
controlar la aplicacién DAW.

® Boton F2 (Pantalla DAW CONTROLLER MARKER)
e Boton F3 EEZEM (Pantalla DAW CONTROLLER MARKER)
o Boton F4 BEEE (Pantalla DAW CONTROLLER MARKER)
@ Boton F2 IEEM (Pantalla DAW CONTROLLER TRACK)
o Boton F3 MEZM (Pantalla DAW CONTROLLER TRACK)
e Boton F4 MMM (Pantalla DAW CONTROLLER TRACK)
@ Dial MULTI JOG (funcion de localizacion)

® Botones <« />>

® Boton H

® Boton /11

® Boton @

® Mandos PAN (1-6, 7/8-9/10)

® Botones REC (1-6, 7/8-9/10)

® Interruptores MUTE (1-6, 7/8-9/10)

® nterruptores SOLO (1-6, 7/8-9/10)

® Faders de canal (1-6, 7/8-9/10)

® Fader FX (control de fader master)

Inmediatamente después de la conexidn con el DAW, asi
como después de que haya hecho ajustes en el DAW, los
ajustes de dicho DAW y el estado y las posiciones de los
botones, mandos y faders del Model 12 no coincidiran. En ese
caso, modifique los ajustes del DAW para hacerlos coincidir
con los del Model 12 o use los botones, mandos y faders del
Model 12 para ajustarlos a los valores del DAW.

TASCAM Model 12 Manual de modo de control DAW 19



Tabla de implementacion MIDI

Tabla de implementacion MIDI de los puertos de control DAW

Funcién Transmite Reconoce Observaciones
. En el encendido X X
Canales basicos
Configurables X X
En el encendido X X
Modo Mensaje X X
Modificado |
. Rango O O Modo HUI: Sensibilidad activa
Numero de nota
Rango O O Modo Mackie Ctrl: Tecla, LED
NOTA on
© © Modo HUI: Sensibilidad activa
NOTA off X X
Velocidad
NOTA on @) O
Modo Mackie Ctrl: Tecla, LED
NOTA off X X
Polifénico X X
Aftertouch
Canal X X
Inflexién tonal (@) X Modo Mackie Ctrl: Fader
O O Modo HUI: Fader, LED, Interruptor Ctrl, PAN
Cambio de control
(@) (@) Modo Mackie Ctrl: PAN, mando giratorio
) X X
Cambio de programa -
Rango deajuste | |
Sistema exclusivo (@) (@) Modo Mackie Ctrl
Posicion X X
. } Seleccién de cancion X X
Sistema comun
Cuarto de fotograma X X
Afinaciéon X X
Reloj X X
Sistema de tiempo real ”
Ordenes X X
Local on/off X X
Todas las notas off X X
Otros
Sensibilidad activa X X
Reset X X
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